Cleaning Aeronca Drawings
Volunteer Guide
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Greetings

Thank you for volunteering your time to help clean Aeronca drawings. This is the most time-consuming and
most important part of the Aeronca Drawing Preservation Project. The drawings are already scanned.
However, the drawings often have non-white backgrounds (usually purple or gray) and non-black lines and text,
(such as dark-purple or dark-gray.) Your effort will be to electronically clean these documents by making the
background white, and the data black. This is necessary to make the drawing easier to read when printed and to
reduce the file size.

This document is supposed to give you the skills to clean these drawings. This document is divided into two
parts. The first part presents the background and concepts of scanned drawings and the problems encountered
when determining the best solution. The second part is a tutorial used to teach you the techniques on how to
clean a drawing by walking you through the process of cleaning a sample drawing. You will need a computer
and Adobe Photoshop.
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The Drawing Preservation Project
To be written.

Background

All the Aeronca drawings are scanned as a grayscale 8-bit drawing at 200 dpi (dots per inch) or greater.

Drawing Sizes
Aeronca made various sizes of drawings, roughly based on the standard engineer drawing sizes of A, B, C, D,

E, and E-plus. However, instead of using these letters, Aeronca used the numbers 1,2,3,4,5, and 7. For
example, drawing number 1-1723 is an 8.5” x 11” drawing, while drawing 4-880 is 22” x 34”.

Aeronca Equivalent

Drawing Drawing

Prefix Letter Size

1- A 8.57x11”
2- B 11”x 177
3- C 177 x22”
4- D 227 x 34”
5- None 0dd sizes
7- E 34” x 44”
7- EE & E-plus | 34” x any”

File Size Problem and Solution

Scanned grayscale drawings have very large file sizes. The 4-, 5-, and 7-size drawings can be from 20MB to
150MB large. Since the Aeronca.com website has a 100MB storage limitation (without additional fees), this
would severely limit the number of drawings that could be presented on the website. Since a CD can hold 650
MB of data, this would also require dozens of CDs to include the entire drawing set. Also, most computers do
not have enough memory to open drawings of this size.

The solution is to convert the drawings to black and white (1-bit drawings) using a technique called
thresholding and enable LZH compression. This will substantially reduced the file size of the drawings. The 4-
, 5-, and 7-size drawings will easy be reduced to 100KB to 300K B, or less.

Risk and Effort Problem and Solution

Converting the drawings to black and white is a time-consuming, non-trivial, and risky.

Time-consuming because it is a very manual effort to convert each small area, especially for the dirty drawings
which seems to be the norm. It can take 2 to 10 hours to clean an average drawing, depending on how dirty it
is. Most of the drawings that have been scanned are multiple-generation copies with terrible data-to-noise
ratios. Very few are ideal drawings, with dark lines and text (data) with bright white backgrounds. In fact,
most drawings have gray backgrounds with darker gray data. Sometimes the data becomes so light that it
disappears into the background. There are some cases when you can no longer read the data, so repairing or
enhancing it will be impossible. The solution to the time-consuming problem is to recruit volunteers to help
with the cleaning effort.

Non-trivial because it requires using complicated software tools (Adobe Photoshop in this case) to convert

many small areas, one at a time. The skills and techniques to clean drawings are often advanced not commonly
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acquired by average PC users. The solution is to create a tutorial (this document) to teach the volunteers the
skills required to clean these drawings.

Risky because if you unknowingly erase data or enhance data incorrectly it could change the meaning of the
drawing. For example, you might guess that a hard-to-read number is a 5, when it is really a 9. Thus a
measurement of 9/16 you just enhanced to read 5/16. In some cases, it is not obvious that this change is made,
nor is the correct data easily verifiable. Another example might be a dotted line that is barely readable in a grey
and highly-speckled background. The solution here is leave data unreadable rather than guess wrong. Also, a
notification will be placed on each drawing telling the viewer that these drawings were scanned and digitally
enhanced and that errors may have occurred.

Basics of Grayscale

All the drawings are scanned as grayscale drawings at 200 dpi or better. Every square inch is broken down into
40,000 (200 x 200) basic elements, called pixels or dots, which is given some value of gray that represent the
darkness (i.e. grayness) of that spot on the drawing. Each gray pixel can have 256 shades of gray. Gray #0 is
black. Gray #255 is white. Gary #128 is exactly halfway between black and white. So Gray #70 is more black
than white, while Gray #240 is very light gray, almost white.

When doing grayscale scanning, the scanner has to decide which shade of gray to assign to each pixel it is
scanning. With 256 shades of gray available, the scanner has a lot of flexibility in assigning nearly the exact
shade of gray. If the scanner is a little bit off, it is not often noticeable. That is, it is difficult to see the
difference between Gray #148 and Gray #149.

3|
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Figure 1: A close-up example of a grayscale scan, before it is cleaned. Notice how the background is gray and
has lots of black speckles and dirt, called noise. Also the line on the right is beginning to fade. When printed, it
can look worse. If you are reading this in printed form, the above figure may already look bad, depending on
the quality of your printer.

Footnote: It takes 8 bits to represent each gray pixel. Since there are 40,000 pixels per square inch (200 x 200)
that means it takes 320,000 (8 x 40,000) bits for each square inch. An A-size drawing at 8.5” x 11”15 93.5
square inches. Thus, an A-size drawing scanned at 200 dpi grayscale requires 29,920,000 bits. An A-size
drawing scanned at 225 dpi grayscale requires a 37,867,500 bits. A large E-size drawing at 34” x 96” scanned
at 225 dpi grayscale requires a whopping 1,321,920,000 bits.

Basics of Black and White

As an alternative to grayscale, each pixel can be simply black or white. No shades of gray. This only requires 1
bit per pixel O=black. I=white. This can be a lot simpler, since there are only two choices, black or white. It
takes 40,000 bits per square inch for a black and white drawing. Thus an A-size drawing scanned at 200 dpi
black-and-white requires 3,740,000 which is 12% of the size of the same drawing in grayscale. When applying
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a compression algorithm such as LZH, the number of required bits can be even smaller, as much as 1% of the
size of a grayscale drawing. There are some clear advantages to black and white drawings when it comes to
size. However, as you will soon see, there are also some disadvantages that we need to learn how to get past.

T
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Figure 2: A close-up example of a black-and-white scan of a very clean drawing. Notice the occasional speckle

and the jagged lines. Still, you can easily read everything on the drawing. Nearly every printer can nicely print
a black-and-white drawing.

If I were to do black-and-white scanning (which I don’t, I only do grayscale scanning) the scanner would have
decide whether to create a black or white pixel for each spot on the drawing. This is easy for the scanner when
a spot on the drawing is very dark or very light. The problem is when it the scanner sees something that is a
shade of gray. When does the scanner decide if a gray spot on the drawing should be a black pixel or a white
pixel?

Thresholding Scanning (Black and White Scanning)

You can scan a drawing as black-and-white by telling the scanner which shade of gray divides black from
white. The scanner can be programmed, for example, to make all grays #128 to #255 to white, and make all
grays #127 down to #0 as black. It is like drawing a line through a spectrum of white-to-black and saying
“everything darker than this will be considered black, and everything lighter than this will be considered white.”
The split between black and white is called the “threshold.” In this example, the threshold is 128. The scanner
can be programed to have a different threshold, such as 200. In this case, all light grays from #200 and lighter
will be white and grays from #199 and darker will be black. During scanning, the threshold is set for the entire
drawing and cannot be changed during the scan of that drawing. This is called a “Static Threshold.”

In my experience, scanning a drawing as black-and-white does not work well when the drawings are dirty,
faded, have dark backgrounds, or vary from one area to another, as many blueprints do. The results are large
areas of complete black or complete white, because the threshold was incorrectly set before the scanning begun.
Sometimes this can be corrected by adjusting the threshold and scanning the document again. Often this can
require many dozens of scans to get the threshold correctly set. The situation is worse when the threshold is
correctly set for one area of the drawing but is not correct for another area of the drawing. In this case, there is
nothing that can be done during the scanning, because there is no concept of “dynamic thresholding” with the
scanners | am using.
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Figure 4: Threshold set too low. 52 in this example. The left side may be OK, but right side too light. Some

data is lost.

Thresholding in Photoshop

To solve this problem of black-and-white scanning, I scan all drawings as grayscale to prevent any data loss
during the scanning process. Then later, I convert the drawing to black-and-white using the “threshold” feature
of Photoshop to make the same black vs. white decision that the scanner cannot do correctly. Photoshop also
has the same problem of static thresholding, in that the entire area selected for thresholding is subject to the
same threshold setting.

Photoshop provides the ability to threshold many smaller areas, one area at a time, each with its own threshold
level. This is the huge advantage over the threshold scanning, which can only threshold the entire drawing at
once. While cleaning a drawing we decided, on an area-by-area, basis which area to threshold and what
threshold level to assign. Photoshop provides a way to easily assign the correct threshold level. Using human
judgment and experience, you can decide the size and shape of each area to threshold, based on the clarity of the
data and the amount of background clutter.

In Photoshop, you select a small area and then command Photoshop to start the threshold process. Next,
Photoshop will display a slide tool that allows you to slide the threshold level from 0 to 255 by your mouse.
While you are moving the threshold level Photoshop instantly “previews” the new threshold results to your
selected area, allowing you to easily see the results of each threshold level. Once you’ve selected the best
threshold, based on what you see, you click the OK button to make the threshold changes permanent for that
selected area. Then you select the next area and start the process again.

With clean, crisp drawings, thresholding is very easy and can often be done using large areas. In this case,
cleaning is easy, fun and quick. Unfortunately, this is rarely the case. Most of the time you are forced to make
your threshold areas very small, sometimes one-inch square at a time, in order to create the best conversion
from grayscale to black-and-white. This can be VERY time-consuming.

i

Figure 5: A clos-e_-up example of thresholding using the best possible threshold number. This example was done
using three small areas.
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Cleanup after Thresholding

Sometimes the nature of the noise (dark and speckles) and data (too light) force you to select a threshold level
that causes some of the background to become black, or some of the data become white. You will see when
you do your first thresholding how you must strike a balance between losing the data and having the
background become too black. In this case, you must take the eraser and delete the unwanted background and
use the pencil to redraw some of the data that was on the wrong side of the threshold. This too can be time-
consuming and tedious.

G~

Figure 6: Close-up example after thresholding, then followed-up with some additional cleaning using the pencil
and eraser.

Intermission
A grasshopper walks into a bar. The bartender says “Hey, we’ve got a drink named after you.” And the

grasshopper repies, “You’ve got a drink named Doug?”

Cleaning Tutorial

The best way to teach you how to clean an Aeronca drawing is using a tutorial. Using a sample drawing, I will
show you how to clean that drawing. I can teach you the basic principles of using Photoshop, but you will have
to continue to refine your skills and learn your own tricks for cleaning. The effort of cleaning these drawings is
60% teachable skills and 40% judgment and experience.

We will be cleaning drawing number 1-2172. This is an A-size drawing and is an example of one of the easier
drawings to clean. Although it is a fairly clean drawing to start with, it does contain some of problems found in
many of the other drawings.

Assumptions

I assume that you have good or very good computer skills. You will need Adobe Photoshop installed and have
a basic understanding of photo editing, including concepts such as multiple-undo, click-and-drag, saving files,
renaming files, dialog boxes, windows, etc.

Getting Started — First-time Set-up

1. Make copy of sample drawing - Please make a copy of the drawing 1-2172 before starting, as you may
need, or want, to keep the original file for reference or for starting the tutorial again. The file name is 1-
2172.TIF. Adobe Photoshop requires a lot of memory, so I suggest you close most of your other
programs before getting started.

2. Start Adobe Photoshop.

3. Close all the sub-windows (toolbars) except the Tools window and the Options window. This can be
done by using the Window menu and de-selecting all the items except Tools and Options.

4. Right click the Marquee tool. (Row 1, column 1 tool bar) Select Rectangular Marquee Tool.

5. Right click the Lasso tool (row 2, column 1). Select the Polygonal Lasso Tool

6. Right click the pencil or brush (row 4, column 2). Select the Pencil Tool.
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7. Right click the eraser (row 6, column 1). Select the Eraser Tool.

8. Select the zoom tool q from the tool bar (row 11, column 2).
9. Put a check-mark in the “Resize Windows To Fit.”

Basic Tools

Here is a review of the basic tools that you will be using in Photoshop. As you become an advanced user you

may find other tools that may be more helpful. But I need to limit this tutorial to a limited number of tools.
Photoshop is a very complex and powerful program and very thick books are written on this subject. My
intention is to just show you the basics.

The Rectangular Marquee Tool. Used to select small sections of the drawing to
apply the next action, such as thresholding or deleting. Click and drag the mouse
pointer over the desired area of the drawing that you wish to select. You will see
a dotted line box around your selection. Then you can apply a function that will
only be applied to selected portion of the drawing.

The Polygonal Lasso Tool. Same as the Rectangular Marquee Tool, except it
allows you to create odd shapes. Click once to begin. Click again to mark each
side of the polygon, then double click the last point to complete the polygon.
After the double click, you will see a dotted line around your selection.

and

Zoom In and Zoom Out. Use this to make the image appear bigger or smaller by
clicking the left mouse button on the drawing. The location of the mouse pointer
will become the new center of the screen. The mouse pointer will show you if
you are in zoom-in “+” or zoom-out “-“ mode. This can be changed by clicking
the zoom-in & or zoom-out ‘= buttons. You can temporarily change the
direction of the zoom by holding the ALT key while clicking the left mouse
button to zoom.

Pencil tool. Used to put data on the drawing. Used to trace over light or missing
data, such as lines or text. Often this is done prior to thresholding while you can

and still see the data you are tracing. The size of the pencil tip is controlled by the
Bruzh: | Brush settings. A setting of 1 is one pixel wide, the smallest you can go. Often
= you will use a size from 2 to 3 for tracing. Sometime 1 for fine drawing.
P, Eraser tools. Used to erase noise after each selected area is converted to black-
4 and-white, called thresholding. Sometimes, in order to force the data to be clear
and and readable you are left with some background that turned black. Use the eraser
Erush- | '@ to delete the unwanted black background. The Brush setting controls the size of
El the eraser. Settings from 5 to 13 are common.
" Foreground and background color settings. Used to control the colors for the
pencil and eraser. In our exercises, as shown to the left, the foreground should be
™ black (used by the pencil) and the background should be white (used by the
eraser.) If this is accidentally changed, reset to the default by click the “default”
button in the lower left of this icon.
AtTAT Shortcut to Thresholding. Press these keys one at a time.
Control+Alt+Z | Undo one change. (Press these key all at the same time.) You can undo up to 10

to 20 changes, one at a time.
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Lesson 1 — Zooming

1.

Open a copy of the Sample Drawing 1-2172.TIF.

[ Adobe Photoshop e _|of x|

File Edit Image Layer Select Filer Wiew ‘Window Help
Actual Fixels I Fit On Screen I Print Size I | ElEBRArEaE ‘ TR -
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Select the zoom tool Clt from the tool bar.  Select Zoom-In

Click anywhere in the picture.
a. You will see the drawing get bigger.
b. The point on the drawing where you clicked will now become the center of the screen.
c. The title bar will show you the percent enlargement. Such as “1-2172.tif @ 300% (Gray)”

Select the Zoom-Out EL

Click anywhere in the picture
a. You will see the drawing get smaller.

Practice zooming by clicking on the circle-A near the center of the picture. Keep clicking on the center
of the A until you reach 800%. You can now see the individual pixels the make up the picture.

You can temporarily reverse the zoom feature by pressing and holding the ALT key while clicking on
the drawing. As soon as you press the ALT key you will see the mouse pointer change to its opposite.
Click as many times as you want to zoom out. When you release the ALT key the mouse pointer will
return to its original position.
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8. Zoom out until the entire drawing fills the screen. This can also be done easily by clicking the “Fit On
Screen” button at the top.

9. Select Zoom-in

10. Click-and-drag Zoom: While in Zoom-in mode, you can quickly zoom in on any point of the drawing by
clicking and dragging a box anywhere on the drawing. When you release the mouse button the box that
you just created will be zoomed-in to fill the entire screen.

11. Zoom in to any point on the drawings.

Lesson 2 — Simple Thresholding

1. Using the Zoom tool, enlarge the word AERONCA for the upper left of the drawing to fill half the
screen, which should be about 200%.

=1
1

2. Select the Rectangular Marquee Tool - L-d,

3. Draw a box around the word AERONCA, leaving some space around it.

4. Start the thresholding process by:
a. Clicking the Image menu
b. Select the Adjustments sub-menu
c. Select the Threshold... menu-item
d. Here’s a shortcut: You can achieve the same result without using the mouse by pressing the
following keys, one at a time - ALT, then I, then A, then T. (ALT,I[, A, T)

5. You should now see the Threshold dialog box.

X

Threshold Level: |[EE]
Reset |

vV Preview

The initial threshold level is set to 128. The histogram shows the color distribution of all the pixels in
the selected area, with 0-black to the left and 255-white to the right. The sliding triangle is currently
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positioned at 128. In this example, you can see there is a large band of light-gray in the 175-to-210
range. These pixels are probably most of the background. There is also a smaller band of dark-gray
pixels in the 20-to-50 range. These pixels are probably the text spelling AERONCA. There are a
smaller number of pixels with gray values between 50 and 175. Note that there are no black pixels (0)
or white pixels (255) in this historgram.

You will also notice the selected area display the initial threshold setting. Initially the setting of 128
looks very good, but let’s play around with different settings.

6. You can change the threshold lever two ways.
a. Changing the number with the keyboard to any value from 0 to 255
b. Using the mouse pointer to slide the triangle. This is the easiest.

7. Slide the triangle slowly to the right until you reach about 190. You will see how the letters get darker
and the background starts to turn black. Clearly, this is less desirable.

8. By the time you reach 220 the entire area will turn black. Very undesirable.

9. Slide the triangle slowly back to the left, observing how the select area changes. Continue left until you
reach 30. It will be too light.
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10. The question is, what is the best threshold setting to make it look the best? Set the threshold to 80.
This is just about the best threshold setting for this example.

AERONCA A

11. Advanced Tip: At anytime during the Threshold-setting process, you can uncheck the “preview”
checkbox to see the original area without the threshold results being displayed. Sometimes, when the
area is very dirty, you will need to switch back-and-forth in order to determine if you have eliminated
data by using too high-level of threshold.

12. Click OK to accept the selected threshold level.

13. To De-select that region press Control-D, or form the Select menu click Deselect.

14. This thresholding example is nearly perfect, since there is very little noise or speckles in the background
and all the data can be clearly read. No additional editing, such as drawing or erasing, is necessary in
this example.

15. Save your work.

Lesson 3 — Choosing the Best Threshold Area

As you learn to clean drawings you will need to refine your judgment of how big, or how small, to make each
area for thresholding. As a guideline, choose areas that have similar background and similar data contrast.
Once an area is selected and you’ve started thresholding, observe the area closely while you are sliding the
threshold-triangle back-and-forth to see if any data starts to disappear sooner than other. If you find that you
cannot find a threshold setting the keeps all your data bright and clear then you may have to cancel and reselect
a smaller area.

This lesson will demonstrate selecting an area that is incorrect for the type of data we are working with.

1. Zoom into the lower right corner of the drawing to about 300%.
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2. Select the four boxes contammg 6- 1 43 MM DATE, and BY.
3 .-:f J o | L ,
Ll 4

3. Start the threshold process. ALT, I, A, T

4. Try to find the best threshold level by sliding the triangle back-and-forth. You will find it difficult to get
the date, 6-1-43, to display clearly at the same time the words DATE and BY look nice. At threshold 28
DATE and BY look ﬁne

ht —"?E'- B _1'_ [ B TR I L R _ql_ -':'
1 ;o
) L 8 " r
o : S
Mo = :

_ = —

1
. DATE BY
i) i
r._._,__, A e - B
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If we adjust the threshold to 100 to make the 6-1-43 look fine, then DATE and BY are not legible.

N R T R P LT TR

5. Cancel the Threshold. We now want to divide this area into smaller areas and do multiple thresholds.
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6. Select an area around the 6-1-43, but do not include any of the borders.

8. Select an area around DATE and threshold it to about 29. Do the same with BY using 27. And do the
same with MM using 74.

9. Now we will finish this lesson with one more threshold that will bring all four areas together. This step
is called “nested thresholding”. Select the four boxes containing 6-1-43, MM, DATE, and BY, like you
did in step 2 above. This selection will include the four smaller areas that you have already completed.
When you start thresholding this area you will see that the areas already completed are not affected by
the current thresholding.

Now threshold this area to the best setting that preserves all the lines and borders while at best keeping
the background as white as possible. I found that a threshold of 110 was the best setting.
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with the results in step 4 above. Although the lines look shaggy and fuzzy all the

Compare this result
text can be clearly read.

10. Save your work.

Lesson 4 — Removing Noise and Background clutter

In order to make the data black, often it is necessary to use a threshold level that causes noise to develop in the
background. Usually this “noise” is in the form of speckles, fuzzy lines, and spikes rising out of the data.
Some of these drawings are folded when stored, rather than rolled. Some noise is created along the folded
edges where shadows and lines cannot be forced into the background. Knowing that you can easily remove this
noise will allow you to emphasize the data more by setting higher threshold levels at the expense of making
noise. In theory, it is a lot easier to detect and erase noise, than it is to detect and recreate lost data. Using a
threshold level that is too low can eliminate important data. We don’t want to lose any data.

IMPORTANT REMINDER: We don’t want to change the meaning of these drawings. We want these drawings
to look like they did when first drawn, mistakes and all. Don’t add any additional data or comments. Some
data may be so bad that you cannot read what it is supposed to be. In that case, leave it unreadable, rather than
guessing. Sometimes guessing is not required as the data may be duplicated elsewhere on the drawing. In this
case, it is OK to rebuild the data. For example, all fractions are followed with the decimal equivalent. Such as:
3/8 (.375) If you cannot read the .375, you can accurately determine or predict it, so go ahead and rebuild it.

We’ll use two techniques to remove noise.
¢ Remove noise after thresholding. (Lessons 4.1 and 4.2)
e Delete background before thresholding. (Lessons 4.3, and 4.4)

Lesson 4.1 Using the Eraser to Delete Background Noise

1. Zoom into 200% and highlight the circled-A and arrow head near the center of the drawing.
Lo .._ ! -1'

2. Do your best to threshold it while keeping as much data as possible. Anything less than 100 starts to
lose the dimension line. For this exercise let’s set the threshold to 125 so that some noise will be
created.
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10.

—
[a—y

. Your results should look like this.
:

Tay

g &

Zoom into 400%. It is a lot easier to erase when the pixels are big and your mouse movements are less
exaggerated.

g Bruszh: : -

Select the Eraser tool s and select a brush size of 9 . The mouse pointer will now
become a circle, the size of a 9 pixel circle. You are now in erase-mode.

K

. Verify the foreround and background colors are at the defaults settings like this: L . If they are

not, reset them to the default by clicking on ., )

While in erase-mode, whenever you click the mouse pointer on the drawing, the pixels under the mouse
pointer will be erased. That is, the pixels will change to the background color. (If your background
color (step 5) is not white, then erasing does not work as expected.)

When you click-and-drag, the mouse pointer will erase everything it passes over while you are moving
the mouse with the button pressed. Release the button to stop erasing. (Click Control-Z to undo the last
erase step if you make a mistake.)

Erase as much of the unwanted noise from the highlighted area as you can. You will have to be careful
near data. You might have to work slowly near the data, erasing several small pieces of data at a time.
Erasing is kind of like sculpting. You cut away a little here and there, step back, and erase a little more
until it looks right. In this case, erasing the noise around the circle-A and the lines will be like
sculpting.

CAUTION: Erasing and sculpting does not have to create perfect, smooth results. You want to remove
the speckles, spikes, and bad fuzz. It would take too much time to perfectly smooth out every single
line, curve, and piece of data. Keep in mind that many of the somewhat jagged and slightly fuzzy pixels
look worse up close. Once you zoom to a normal view, it will look better.

R TR

X '____"'_"?‘____'.'_ ________ e

ek J CRTag
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Lesson 4.2 Using the Rectangular Marquee to Delete Background Noise

2. You will have de-select the current selection (Control-D) before selecting another area.

3. Using the Rectangular Marquee Tool select large sub-areas of noise, then press the Delete key. The
purpose it to quickly erase large areas of noise without having to use the round, tiny eraser. Since the
lines are the drawing are not exactly horizontal and vertical, your box can get close to the line at one
point, but then not so close at another point.

=

L 1,

L] s [

4. Because of the sloping data, you may have to use several smaller rectangles to get into the narrow
spaces.

L e

5. Without having to redraw a rectangle, you can move the current rectangle by clicking and dragging it to
a new position. Since the current rectangle is the probably the correct size, drag it to the middle of this
narrow channel we’re cleaning and erase the noise.
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6. Now drag the selection to the right side and delete

.r.j- . ..l_'l' h -

=

7. Continue drawing rectangles and deleting for all the areas that are appropriate, which is just about
everywhere on this section. You’ll learn that you can use very small boxes, say 9-pixels wide, very
much like the eraser. Once you create the selection box, you can keep dragging it around and erasing
with it. The difference is that you have a square shape, rather than a circle, that can get into corners and
edges better.
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Lesson 4.3 Removing Background Noise Before Thresholding (with Rectangles)

Often there are large areas of background that have no data, but is loaded with noise, speckles, and folding
marks. There is no sense in thesholding and cleaning these areas since we can easily delete those areas in one
step. The border areas are very good candidates for this method, since they are often dark or black, but they are
supposed to be just white borders.

This exercise will have you identify those areas that can be selected and deleted rather than thresholding.

1. Start near the upper edge, about 3” from the left, outside the border. Select an area including the upper-
left corner, as shown below. We will leave the borderline for thresholding later. How close you get to
the border line depends on how noisy the background is. If the background next to the border is fair to
good, then you don’t have to get real close. When we threshold the border, we’ll include the undeleted
background. Thus, if your borderline goes on a slight angle, your selection can start close to the border
and then drift away quite a bit over a long distance. However, if the background next to the border is
very noisy, then you’ll have to make several smaller selections to prevent you from drifting too far from
the border.

HINT: Since it is hard to start a selection on the very edge of the drawing, always start your selection
inward and create the selection outward. This allows your mouse pointer to go outside the drawing
frame, but the selection box will stop at the edge. That is easier than trying to start a selection right on

the outer edges of the drawing.
i EiF i

w3 1-2172.kif @ 100% {Gray)

2. Select another area to the right of the last one and delete the background.

3. Continue selection areas along the top border until you reach the right side.

iy LR Sen

4. Continue down the right side. You can use longer selection then what is shown here. Remember to start

from the inside and select outwards towards the corners.
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5. Continue all the way around the outside of the border.

NOTE: Sometimes you will have to abandon a selection when you realize that you’ve started to run into
the borderline. In those cases, de-select (Control-D) and start again in a different location.

6. Now for work inside the border. Select and delete the large area near the upper right of the drawing.
Careful not to select the centerline extension of the drawing.

7. Continue selection large areas of background and delete them.

HINT: If you start selecting an area and realize you have run into some data or you are a few pixels off, you
can sometimes finish the selection, although wrong, and then drag (tweek) the selection into a better position by
moving it a few pixels one direction. This assumes that you have room on the other side of the selection.
HINT: Once you selected an area, you can zoom in and zoom out at any time. This is useful if an entire

selection is not on the screen. You may be zoomed in close to accurately make a selection. Then you can zoom
out to make sure you’ve missed selecting any data before deleting contents of the selected area.
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8. You’'re results should look something like this.
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Lesson 4.4 Removing Background Noise Before Thresholding (with Polygons)

Sometimes rectangles are not the best shape for selecting backgrounds to delete. In this lesson, we’ll learn how
to create customized-shape selections using the Polygonal Marquee Tool.

This tool works by clicking at each corner of the polygon you want to create. After clicking once for the first
point, a dynamic-selection line will follow the mouse pointer until you click the second point where the
selection line will now remain between those two points. You keep clicking points and “laying down” the
edges of your polygon until you’ve come back near the first point, where you will double-click to stop the
process. After the double click the selection area will be display with a dotted line.

1. Zoom into the area near the middle of the drawing near the “3/4” measurement.

2. Select the Polygonal Marquee Tool E:ja

3. Select the trapezoidal area that is to the right of the “3/4” measurement above the circle-A. I suggest the
first click be in the upper left corner and proceed counter-clockwise. Run right along the side of the
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angled-arrow, jotting around the head of the arrow. Delete the area.

4. Create another polygon around the area to the right, jotting around the “2 15/16” measurement and the
hole-centerlines to the right.

o el e i i —a
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5. Continue selecting and deleting the background using this method. The objective is to select and delete the
background to prevent noise when thresholding is done.

T H'R.H . : G T T
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Lesson 5 — Rebuilding Lost Data

No matter how hard we try, sometimes the data is so light and the background is so dark that we cannot find a
threshold level to make the data visible. Many times, we as humans can see the data in grayscale, but it
disappears during thresholding. In these cases, we may need to rebuild the lost data using the Pencil Tool.

Preferably, you will use the pencil to trace over the data prior to thresholding. But sometimes it is easier to
rebuild the data after thresholding. The danger of doing it after thresholding is that you no longer have the
original data to trace. If you get interrupted or if the area you are rebuilding is too large you may forget what
the original data was. Many times it is very obvious what you are rebuilding, such as the stem of a letter, a
straight line, part of a number, that could really be left alone, but looks better if it were redrawn.

1. Highlight the area that has “#28 Drill”

2. Try to threshold it. You will find that top of the “L” in HOLE is almost gone. To darken the stem of the
“L> at all causes the “O” to get filled in. Even if you select just the “L” you’ll never be able to get the
top reappear. Here I selected a threshold of 106. We lost some of the underline and the “L”.

‘ *28 DRILL(.140)

PR

2 HQ E THRU

,/"J Bruzsh: | © |
3. Select the Pencil Tool  Select a pencil tip “brush” of about 2 pixels z

4. Zoom in real close, like 500%. The more you zoom the easier it is to draw accurately.
5. You can click once to draw a 2-pixel dot. You can click-and-drag to draw a line. Rebuild the stem of
the “L” using your mouse. You don’t have to draw a perfect “L”. In fact, if you are too straight and

perfect it will look unnatural. Remember, from a distance it will look great.

HINT: If you make a mistake, you can “Undo” with Control-Z. You can undo the last 10 or so actions
with Control-Alt-Z.

HOLE

| el - - Jepgesbesssss - il -wll
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6. Rebuild and fill-in the missing underlines using the same pencil tool.

| 728 DRILL(.140)
| HOLE THRU

7. Use the Eraser Tool to clean up the noise in the “O”, the “4” and elsewhere.

| 28 DRILL(.140)

| HOLE THRU

8. Let’s do another. This time we’ll trace before we threshold. Select the area that has the words “1-117”
Find the best threshold. I picked 124. This setting reduced most of the noise, but part of the “30” (or is
it an “80” ?) cannot be seen.

9. Undo the thresholding with Control-Z
10. Zoom into the “30” or “80”. It is pretty clearly a “30”

11. Select the pencil tool. Trace this missing parts of the “30”. Notice that you don’t have to trace the
entire number. You only need to trace over the light or missing parts.

l — l }IE"‘.‘&» u.-.--ao .
. o e ——— a:
o f !
’ g Ty i
12. Try thresholding it again. [ used 112. Erase some of the noise.

b~ 17 -2 -30

| REQD.

Save your work.

5
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Lesson 6 — Enhancing Lines

Many times, lines that are too light will not turn black during thresholding. We can use the pencil to redraw the
line. However, it requires a steady hand draw straight for a long distance.

We have two options to tracing a line with the pencil.

1.

Copy a portion of a similar line from elsewhere in the drawing

2. Select the line with a long, narrow selection box, and threshold it to 255, which forces all the pixels to

black.

Lesson 6.1 — Enhancing Lines — Cut & Copy

1.

We will focus on the area on the left that begins with 17/64. It is obvious without attempting a
threshold that a portion of the top underline is too light. Zoom in to about 200%

B4 L)KILLW

R r-ﬁ’:h

Select the darkest portion of the top underline with a long, narrow selection box.

A L)KELL{.;&&

Select Copy for the Edit menu. Or press Control-C

Select Paste from the Edit menu. Or press Control-V. Several things will happen.
a. The selection box disappears.
b. The words “Layer 1” appears before the words “Gray” in the title bar of the window.

'-1'.: 1-2172.tf @ 100% {La',rer 1, Era',r}

c. What has happened is that a new transparent layer has been added that is above the drawing.
The pasted line has been placed on this layer exactly above the location where it was cut. You
can move this pasted portion around this layer to the location you want it, without disturbing the
original layer below. When you are done, we will merge this upper layer down into the drawing.

D
Select the Move Tool k3

Move the pointer directly over the line you just cut and past. Click and drag the pasted line into its new
position. If you decide you cut and pasted the wrong (or a bad) line, then undo the last two actions by
pressmg Control Z tw1ce until Eou see the words “Layer 17 disappear.

& DRiLUikeer

L nrﬁ*h e

Select “Merge Down” from the Layer menu, or press Control-E. The words “Layer 1 should disappear.
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8. Since we have another part of the line that could be fixed, let’s continue.
Paste a second copy of the line portion, by pressing Control-V. This time the pasted line might appear
somewhere else on the screen. “Layer 1” should appear again.

9. Again, move the pasted portion into the desired position on the upper underline.

10. Merge Down, but pressing Control-E.

Ei DKILLLeeE]

e %

11. Threshold the area and do some slight cleaning with the pencil and eraser.

é-za. DRILL(26E
2 REQD

12. We are done with this technique. Save your work.

Lesson 6.2 — Enhancing Lines — Threshold-to-Black

1. We will focus on the diagonal arrow from the “#28 Drill”.

v

v,

2. Select the Polygonal Lasso Tool
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3. Select a polygon that tightly outlines the diagonal line.
&

<
ol

/

- A

4. Threshold this selection to a value of 255, which will make the entire line black.
5. Deselect the selection, Control-D.

6. Threshold the line and the gray background around it. No cleaning will be required.

7. Ifyour lines are very stfaight, or straight enough, you can use the Rectangular Marquee Tool instead of
the Polygonal Lasso Tool.
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8. Select the following area

9. Force the line to black by thresholding to 255. Deselect.

10. Threshold the entire areas and cleanup.

11. Although these examples were very simple and this drawing does not have many lines, there are some
drawings where a great number of lines will need to be enhanced.
12. Save your work.

Lesson 6.3 — Faster method for Threshold-to-Black
The technique learned in lesson 6.2 is great, but can require many mouse clicks or key clicks to complete. That

is, once you’ve selected an area tightly around a line that you want to force to black, you then have to press
ALT, I, A, T,2,5,5, then ENTER. That’s eight keys to press to force the current area to black.

This lesson will show you how you can record this “action” so it can be played back with one keystroke.
You will only need to do this once. Photoshop will remember this action from now on.
1. Select any area that you want to threshold to black. The size or shape does not matter and will not be

memorized.
2. Open the Actions palette by selecting the Window menu and then select the Action item.
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3. Click on “My Actions” to highlight it.

Histor Actions

Tool Presets

-|7 | E [ || Default Actions.atn 3
EAIN ] vy ctions |

[ [r Action

L

EH @

0 Rl @ |4

4. Click the New Action button al near the lower right of the Actions palette. You should see the “New
Action” dialog box.

5. Make the following selections. Set the Name to “Threshold to black.”
Change the Function Key to F3.

Mew Action

Mlame:

Set:

Function Key: I ~| I shitt ™ control

X

Threshald to black

Recaord

My ACtions

Color: | [ ] Mone j

=

Zancel

6. Click “Record”. Henceforth, all your actions will be recorded.

7. Threshold the currently selected area to black using the menu method. That is, don’t use the key clicks.
That is, select Image menu, Adjustments sub-menu, Threshold item. Adjust the threshold level to 255

and click OK.

8. Click the Stop Recording B button on the Action palette.

9. You are done recording this action. You can now close the Action palette.

10. To test your recording, select another area that you want to threshold to black.

11. Press F3. Shazam! The selected area should have changed to black.

12. Save your work.
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Lesson 7 — Dust and Scratches

Sometimes after thresholding, the letters, numbers, and lines are very fuzzy and there are many small (1 or 2
pixel) dots. By using the “Dust and Scratches” filter in Photoshop you can often smooth out the fuzz and
eliminate the small spots.

WARNING: This operation can also make the data worse. When you use this feature, you must examine the
results carefully to determine if it is improving or degrading the data.

WARNING: You must select the Dust and Scratches filter only once for each area, because each time you apply
it, it keeps smoothing the data. It very quickly starts to destroy the data if you are not careful. Keep your eyes
open on this one. As a guideline, don’t apply Dust and Scratches more than once.

1. We’re going to focus on the section with “1-467".
2. To start, enhance the lines in this section.

,h 467-062-108
3%4 DR!LL(SSI)
IE.FI REQD. =

3. Threshold the area to 128.

1-467-062-108
(2% DRILL(SBI)
| EA REQD.

4. Select the Filter menu, Noise sub-menu, then select Dust and Scratches.
a. Setthe Radius to 1
b. Set the Threshold to 0
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c. Click OK.

[ 1-467-C62-108
(2% DRILL(391)
[_I E6 REQD

5. Notice that the decimal points on “.062” and “.391” are almost gone. Also the lines are starting to break
up. And the “0” and the “8” starting to merge together.  If you notice and fix these problems, then this
feature can save you a lot of cleanup time.

6. Fix some of the data and save your work.

[ 1-467-062-108
2%4 DRILL(39i)
1 ES8 REQD

Lesson 8 — Finish Thresholding

Using all the techniques above, finish thresholding, section by section.

1. You will find the drawing number in the upper right corner will threshold very nicely.
a. Before

b. Action: Threshold to 70. Very little cleaning above the “1-*
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c. After

2. The border lines can be done with long narrow selections.

I'i "2 B | mnl

b. Action: Threshold to 153. No cleanup.

c. After
3. Molr-e-
a. Before -
- 1 i i o e S
[ED DIMENSIONS ARE IN INCHES AND LIMITS TO 88 WATHIN +: /35
b. Action: Threshold 66. No cleanup.
c. After o
- I L T ™ —

1D DIMENSIONS ARE IN INCHES AND LIMITS TO &2 WATHIN + }‘31

4. The lower right corner:
Action: LET, CHANGE, A, B, C, D, E, F threshold to 50
Action: Handwriting threshold to 100
Action: All the remaining threshold to 115
After.

aoow

—_ -

c o — T |‘ -

. ]

a |0, whs -2 Ko WAS 2 Ng [61-43(M M
- i j

1

DATE | BY

LEY | CHANGE

L gt

5. Finish the rest of the drawing. When done, there should be no more gray. Everything should be black
and white.
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Lesson 9 — Final Conversion and Saving as Black and White

Although what you see is a black-and-white drawing, it is technically a grayscale (8-bit) drawing with all the
pixels set to 0 (black) and 255 (white). We want to convert this drawing to a 1-bit drawing.

1. Select Image Menu, select Mode, select Bitmap.
Bitmap |

— Resolution 0
Input: 200 pixels fAnch

Cutput: Iﬁ ﬂl

| pixelssinch j

— Method
se: | Diffusion Dither |

Custanm Fattern: -

2. Make sure OUTPUT is set to 250.
Click OK.
4. Saving the drawing with compression.
a. Select File, select “Save As...”
b. Without making any changes, click the SAVE button.
c. Click YES, to “do you want to replace this file?”
d. Under the Image Compression section, select the LZH option.
e. Click Save.
5. You’re Done. Good luck and thank you.

(98]
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